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XT Panel Records and Excel Spreadsheets
APP-026

General:

The XT-70 control panel up to 25 parameters to be chosen to use for records. Not only can the specific
parameters to use be chosen, but so can the order of the records. The XT-70 will save 78,000 records
and then will rollover when full by deleting the oldest record and replacing it with a new one. The
records can be downloaded from a web browser or from the HMI. When downloaded with a web
browser, they are loaded into a spreadsheet. It is also possible to access the data directly from a
pre-setup template.

The XT-70 will also store refrigeration records for up to ten devices. The ten devices can be any
combination of CR and ER cards. It will store up to 17000 records for each device. The records will
also rollover when the slot is filled. They can be downloaded like the XT records.

The records are composed of both a historical averaged record and also an activity log. The time for the

historical averaged record can be set. The activity log record will be generated any time there is a mode
change. The activity record is not averaged and is an instantaneous record.

Records Setup:

The format of the records is controlled by a CSV file that can be edited in Excel. This file will also allow
the changing of the names of the pile sensors and the humidity and CO, sensors. There are numerous
files already built that can be used and modified. These files are available on the BTU Tech website.

At any time, it is possible to download the existing file that the XT panel is using and make changes to it.

Access the panel via the webpage and click on | Caonfigure Site

On the Configuration page, click on  Inf Manager

Now click on Download Current Card Confisuration File

Opening Download_Inf.csv d| Click on OK and the file will open in Excel.

ou have chosen ko open

Ej Download_Inf.csy

which is a: Microsoft Excel Comma Separated Yalues File
from: http:f/192,164.1.55:4005

Click on File> Save As.. and use a name that will
describe the panel. Changes can now be made.
When done, save the file and upload it back into

the panel.
What should Firefox dao with this File?

Microsoft Excel For wWindows (default)  »

I Ok l [ Caneel ]
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The following shows the format of the CSV file. The sensors highlighted in yellow can be named. The
record index refers to the order in which the values will appear in the records. All record index fields
must have a value. If not being used, then insert a zero.

[XT_INF_01]

[XT]

<Plenum T - reference only>
<Start - reference only>
<Qutside T - reference only>
<Return T - reference only>

<record index>
<record index>
<record index>
<record index>

TERMINAL LABLE

<Pile 1 - configurable> <record index> AN5
<Pile 2 - configurable> <record index> ANG6
<Pile 3 - configurable> <record index> AN7
<Pile 4 - configurable> <record index> AN8
<Pile 5 - configurable> <record index> AN9
<Pile 6 - configurable> <record index> AN10
<Pile 7 - configurable> <record index> AN11
<Pile 8 - configurable> <record index> AN12
<Qutside H - configurable> <record index> H1
<Plenum H - configurable> <record index> H2
<CO2 level - configurable> <record index> H4
<Door Open - reference only> <record index>

<Operation Mode - reference only> <record index>

<Secondary Mode - reference only>  <record index>

<Refrig Output - reference only> <record index>

<switch status 1 - reference only> <record index>

<switch status 2 - reference only> <record index>

<switch status 3 - reference only> <record index>

<output status - reference only> <record index>

<Return H - configurable> <record index> H3

<Freq Drive Current - reference only>
<Daily Run - reference only>
<CPH - reference only>
<Pile T - reference only>
<Pile H - reference only>
<setpoint - reference only>
<target - reference only>
<CO2 SP - reference only>
<humid sp - reference only>
<cooling sp - reference only>
<refrig sp - reference only>
<timed sp - reference only>

<record index>
<record index>
<record index>
<record index>
<record index>
<record index>
<record index>
<record index>
<record index>
<record index>
<record index>
<record index>
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CSV Example:
[XT_INF_01]
[XT]
PLENUM T 4 The numbers refer to the
gLﬁ‘_z-erE T g order of the records.. In this
example, the operation
RETURN T 7 mode will be the first value,
o NE 8 then the secondary mode,
Highlighted names NW 9 setpoint and so on.
can be changed to SE 10
any name you SW 11
e M 2
mum. Middle 13
Center 0
Unused 0
OSAH 14
PLEN H 15
CcOo2 17
DOOR OPEN 18
OPERATION MODE 1
SECONDARY MODE 2
REFRIG OUTPUT 19
SWITCH STATUS 1 20
SWITCH STATUS 2 0
SWITCH STATUS 3 0
OUTPUT STATUS 21
RTN H 16
FREQ DRIVE CURRENT 0
DAILY RUN 0
CPH 0
PILET 0
PILEH 0
SETPOINT 3
TARGET 0
CO2 sP 0
HUMID SP 0
COOLING sP 0
REFRIG SP 0
TIMED SP 0

Timestamp OPERATION MODE SECONDARY MODE SETPOINT PLENUM T START OUTSIDE T
4/2/2009 0:00 WARMING 39.7 40.2 60.1 91.9
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Refrigeration records:

[CARD_1]

Discharge Pressure
Suction Pressure
Suction Super Heat
Amps

Output

Mode

Lead Compressor
Suction Temp
Discharge Temp
[CARD_2]

Discharge Pressure
Suction Pressure
Suction Super Heat
Amps

Output

Mode

Lead Compressor
Suction Temp
Discharge Temp
[CARD_3]

Suction Press A
Suction Temp A
Suction Press B
Suction Temp B
Super Heat SP
Super Heat A
Super Heat B
Valve pos A
Valve pos B
Mode

ONOO OO PR, OWN -

ONOOPDOWN -

-—
OO PR~ WNOWOWNO O

The refrigeration records are laid out in the same CSV file as
the XT records. There can be up to ten devices and can be
cut and paste to match up to the system. All cards must be in
order, starting with Card 1. Below each card, identify the
card type. 1 =CR-110 and 2 = ER-110 (required).

The numbers will set the order in which the values will
appear.

Once the file is set as desired, then save it as a CSV file and
use a name that references the given panel. Now upload the
new file to the XT panel. Generally, when changes are made
to this file, the records should be cleared.
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Records Request:

There are a number of ways to retrieve the records from the XT. The first and easiest way it to use the
web interface and select the desired date.

oad Panel ds Any start date and ending date that has valid records can
be entered. The start date begins at midnight. Thus, if
Eecord count: 1814 today is the 4/2/09 and only today's records are wanted,

use a start date of 4/2/09 and an end date of 4/3/09.

Start date:; { {

When Retrieve records is clicked on, a choice is given to

End date: 009 save the records or to open them in a spreadsheet.

The next way to get records involves using a host of other applications to download the records. This
could be a database, a spreadsheet or a custom program. Any records request involves the IP address
of the panel.

There is a variable format that would allow one to automatically pull records from any date and there is
also a two day and a seven day fixed dump of records. The two day and seven day format are
addressed here first.

The format for the last two days records is http://<ip address>/records_2days.csv

The format for the last seven days records is http://<ip address>/records_7days.csv

For example, to retrieve the last two days of records for an XT-70 panel at 192.168.1.55 at HTTP port
4005, the request would be: http://192.168.1.55:4005/records_2days.csv

To load these records in an Excel spreadsheet, do a file open and use that address for the “File name:”
field.

Open @@ The XT panel acts
. = : much like a hard-
Lok in: ) R - B - Tools = : ;
| = Q drive. The differ-
a0 | Emry | el | hediied_| ence s that the
8 ean Quinn older .
) maple screen captures Falder 11/13/200¢ athrr?8§ ct>r pattht IS
) OLD C5v Folder Q2512005 VIa_ € Internet 1o
. 5 R&D records 10-15-08 Falder 10/20/200¢| 9@in access the XT.
5 R&D Unit Folder 11/13/2008
@ inf file Format ril.xls 45 KB Micrasoft E... 9f24)2005
@ inf file Formak rey 12.xls 39 KB Microsoft E... 2/16/2003
34 06 Projects Z0081104.xIs 1499 KB Microsoft E... 11/10/200¢
@ RG¥ Cheat sheet,xls 20 KB Microsoft E... 10/28/2008
@ Ry Rev 11 Template Galaxy CR ER. xls 82 KB Microsoft E,,. 9/25/2003 /
i <

>
= File narme: |http:,|',|'192.168.1.55:4DDS,|'rec0rds_2days.csv A ﬂ = Cpen *l
Files of bype: |P.II Microsoft Excel Files (*.x*; *.xs; *.xIt; *.htm; *.html;ﬂ Cancel
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Two day and Seven day Templates:

The purpose of a template is to set up some predefined graphs and to be able to instantly download the
data and apply it to the graphs. Excel allows one to build and save templates. Excel's normal file exten-
sion is xIs. An Excel Template will have an extension of xIt. With a Template, one can set up graphs
and different displays which will automatically load the data for the last two days or seven days when the
spreadsheet is opened. The best way to start is with the BTU Potato Template.xlt file. Open this file (it
may take a while to timeout if it is not pointed toward any data). The first thing to do is to point it toward
the correct XT panel. To do this, click on the Record Tab at the bottom.

214301 44 43.5 45 Click on any cell, then go Data> Get External Data> Edit Text Import.
Y Chart 1 4 Chart 2 4 Chart 3 % Records /

Ed Microsoft Excel - BTU Potato Template rev A.xlt

Eile Edit Miew Insert Format Tools | Data \Window Help

2} sort... EBEE 2 2 2 A
Negal sl y ¥ E"ter "1 il - 10
QFT, .
| E24 ﬂ = 40.2 Subkokals, ..
A D [ E | J I L
- alidakion, ..
1 Timestamp |SETPOINT PLENU FILE 1 FILE 2 PILE 3 PILE
2 | 3/31/08 0:00 a4 07 Table.. 401 | 412 | 402 | 39¢
3 | 3/31/09 0:30 a4 407 Testto Columns... 401 | 412 | 402 | 3@F
4 | 3/31/09 1:00 a4 407 et 401 | 412 | 402 | 39F
5 | 3/31/09 1:30 a4 WE o d outine L4001 412 402 39f
6 | 3/31/09 2:00 a4 e 7 401 | 412 | 403 | 3@F
7 | 3/31/09 2:30 a4 40.7 3] pivatTable and PivatChart Report,.. | 401 | 412 403 39f
8 | 3/31/09 3:.00 a4 407 ant 419 ana | A
9 | 3/3109 330 44 407 Get External Data
10 3£31409 4:00 44 anz ! Refresh Data
11 | 3/31/09 4:30 a4 407 P 7 GiERE
12 | 3/31/09 5:00 a4 an7 45 337 39.9
13 | 3/31/09 5:30 a4 405 45 34.9 399
14 | 3/31/09 6:00 a4 406 45 353 399 o, [T
15 373109630 | 44 406 5 35.4 399 | - USSR
16 | 3431409 7:00 44 407 45 35 395  [E&f' DataRange Properties
17 | 33108 7:30 a4 4073 45 355 38.4

K 3|
File name: |htt|:|:|f||'192.168.1.55:4I:II35,|'rec0rds_2da3fs.csv ﬂ = Open '|
Files of bype: |.ﬂ.ll Microsaft Excel Files {*,x*; *.xls; * xlt; *.htr; *.html; j Cancel

Type in the IP address of the panel using the colon between the IP number and the HTTP port number.
Records for either the last two days or seven days can be chosen here.

Click on Open and the file should load the new data for the last two or seven days.

Do a Save As on this file and name it according to the panel name. Make sure that the file extension yis
for a template (xIt) and not a worksheet (xIs).

Now any time this file is opened, the last two days of data will automatically be loaded.
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The main part of the template is to get the data to load into the records page. The trick is that the exact
number of records is unknown. Thus when the graphs are set up, they have to be inclusive of just the

data. The BTU template can easily be modified it for a specific application.

Chart 1 is a dual axis graph and has temperatures on the left side and output percentage on the right

side.
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Qutput

—— SETPOINT
FLEMUM T
CUTSIDE T

—— REFRIG QUTPUT

—RETURN T

——DOOR OPEM

To make a change to the parameters being graphed, right click on the graph and select Source Data.
Remove parameters by clicking on the parameter and then Remove. To change a parameter, select the
parameter, determine which column the needed
parameter is in and then change the alpha char-
acter in both the Name and Values boxes.

Series
Mame:
PLEMUM T
OUTSIDE T
RETURM T
DoOR OPEM j Yalues:

Add | Remove |

the Values field.

|=Records!$D$1

T

|=Recardsi$Dgz 404137

T

To add a button, click on Add. Then go to one of
the other sensors and copy the Name string and
paste it in to the new one and change the alpha

character to match the desired value. Repeat for
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Getting Date Specific Data:

The second way to download data automatically is by using a date specific format. This will send a
beginning date and ending date for the records. The request string would be as follows:

http://<ip address:port #>/records.csv?a=x&b=x&c=x&d=x&e=x&f=x&g=18&h=x
Where

a = record start month

b = record start day

¢ = record start year
d = record end month

e = record end day

f =record end year

x = value for corresponding variable

g=1 this variable is only needed if the request is sent by an automated device, i.e. HMI, VPN, etc.

It forces the formatting of the CSV to be strictly comma separated values with no other HTTP formatting.
h =0 to 10 this variable indicates which device the request is for: 0 = XT, 1 to 10 = refrigeration cards

Example: to request records from a panel with an IP address of 192.168.1.55, HTTP port 4005, start
date 4-3-09 and end date of 4-4-09, send the following request:

http://192.168.1.55:4005/records.csv?a=4&b=3&c=2009&d=4&e=4&f=2009&g=1&h=0
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